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HOLE WIZARD
This tutorial provides step by step instructions on how to use the HoleWizard. Wewill start this part
with an existing stock condition and tools that are already in the crib. In this exercise wewill create
five hole types using the HoleWizard: bolt holes, a bore hole, drill holes, reamed holes and tap
holes. Additionally, we will need to create a tool to satisfy the Hole Wizard Checker andmanually
change a process from the HoleWizard’s recommendations.

Note that this tutorial is based on the HoleWizard’s default preferences. If you havemodified the
defaults youmay have different results than shown in the tutorial.

Set Up
1. Open the part, "Hole Wizard tutorial.vnc".

The elements to bemachined include twelve 10mmholes, four 16mmholes, one 50mmhole, four
5mmholes and eight points that need to be created. The pre-defined stock is a short 160mm
cylinder with a 76mmboss in the center. The total depth of the stock is 32mm.

In this part we have 14 pre-loaded tools including endmills, drills, spot drills, center drills, counter
sinks, a tap, and a reamer. There is also an empty space at tile #8 for a tool we will need to add later
in this exercise.

New Bolt Table Entry

1. Select File > Preferences.

The Preferences dialog box opens.



HoleWizard

4

2. Click theMachining Prefs tab and then,
under HoleWizard, click Bolt Table.

Double-click in the next empty positions’Nom Size cell. Type "Tutorial 13". Add the bolt hole
definition shown: D2 = 16, L = 3, D = 13, D1 = 13, A = 0.

Wewill be using this later in the tutorial when we create Bolt holes.

Clicking the Tab key tomove between fields is an easyway to navigate the Hole
Wizard’s tables.

3. Click theOK button to close the Preferences dialog.

The new entry is saved.

Creating 10mm Holes
There are four steps to creating these holes: select the hole shape, define the hole size, select the
hole position, and build the processes and operations.
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Step 1. Select the Hole Shape

Wewill now make the first set of holes. These are basic drill holes that are 10mmwide with a 1mm
chamfer. The Full Diameter Depth extends to the bottom of the existing stock condition, which is
32mm.

1. Open the HoleWizard. To access the Hole
Wizard from theMainmenu bar,

clickFeatures > Hole Wizard. You can
leave the Hole wizard dialog open
throughout the exercises. Click and hold
the Title bar to drag the dialog to a
convenient corner of the workspace.

2. Click the Drill button.

The HoleWizard - Step Two: Drill Hole dialog displays.

Step 2. Define the Hole Size

1. Enter the values in Step Two as
shown.

A stock depth of 20mmwill take the drill through the part.

Note that the Chamfer Angle should be set to 45. As this is a Thru hole, we do not need a Tip
Angle. The available angles are derived from the tools in the Tool List.
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The Spotting, Drilling and Drill Chamfering processes have all been selected by the HoleWizard.
Youmay have noticed that as you input or changed numbers that these optionswere being
selected or unselected. The HoleWizard is comparing the size of the hole against the Knowledge
Base to determine what is needed tomake the hole. Youmay deselect any process you do not
want to create.

2. Click theNext button.

Step 3. Select the Hole Position

Notice that several tools in the tool list are highlighted. These are the tools the HoleWizard has
selected for the drill holes.

If the required tools were not found or if there was something wrong with the
settings for this drilling process, the Hole Wizard Checker would alert you. If you
were to go back to Step Two and open the Hole Wizard Checker by clicking the
red check sign, it would look like the following image.

3. Enter the clearance values as shown.

This will set the clearance to be 3mmabove the defined surface (1) and the Surface Z to be at -
19mm (2). On the previous dialog, we specified this operation’s Full diameter Z to be “20”, meaning
20mm from the Surface Z. The Surface Z value of -19mmminus the 20mmdepth of the cut is -
39mm. This ensures the full diameter of the drill is below the bottom of the existing stock. The value
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at (3) is calculated incrementally from the top drill surface and themaster clearance plane set up in
the Document Control Dialog.

We need to designate which geometry to machine.

4. Ctrl-click the circles shown below in a
clockwise order. This is advisable as the
clearance is not set high enough to clear the
central boss and toolpath travelling over it
would cause gouging.

Step 4. Build the Processes and Operations

1. Click the Build Processes button.

You can verify the processes created by opening each one or skip to the next step in the tutorial.
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Clicking Build Processes sets up processes
based strictly on the HoleWizard’s default
preferences. Looking at the three processes
created, we see the first drilling process is using
the 8.5mm spot drill, cutting 1mmdeep. On
moves between holes the tool will retract to -
16mm, or 3mmabove the existing stock.

The second drilling process uses the 10mm
drill. The drill will peck to -39mm to clear out the
hole. It too will retract to -16mm tomakemoves
between holes.
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The third drilling process uses the 14mm
counter sink to create a chamfer. The tip of
counter sink will machine to -25mm to create
the chamfers. It too will retract to -16mm to
makemoves between holes.

If you accidentally changed any of these settingswhile looking at them click the Rebuild Processes
button.

2. Click the Build Operations button.

Since theMachining palette is open we could have used the Do it button to create the drilling
operations, however, we would have lost our associativity with the HoleWizard.

3. Click the Finish button to close the HoleWizard.
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4. Render the Drilling
operations.

13mm Bolt Holes
There are three steps to creating these holes.

Step 1 Select Hole Shape

Wewill now make the bolt holes. Be sure to deselect the operations you just made and delete the
processes from the process list. This way you will not overwrite any operations.

1. Click Features > Hole Wizard to return
to the Hole wizard.

2. Click Bolt Hole.

The HoleWizard - Step Two: Bolt Hole dialog displays.
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Step 2 Define Bolt Hole

1. Click the pull-down arrow on the Size
dialog and select the entry we created at
the beginning of the tutorial. Enter a 13mm
stock depth.

2. Click theNext button.

Two tools in the tool list are highlighted. These are the tools the HoleWizard has
selected for the drill holes.

If the required tools were not found or if there was something wrong with the
settings for this drilling process the Hole Wizard Checker would alert you.
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Step 3 Select the Hole Position

TheHoleWizard - Step Three: Pattern dialog
appears. Wewill use the same clearance
values as those used for the drill holes. The
previously entered values are already the
defaults.

We need to select which geometry to machine. There are two sets of circles for each hole. It doesn’t
matter which circle you choose because only the center point will be used.

1. Select the circles shown.

2. Click theNext button.

Step 4 Build the Processes and Operations

1. Click the Rebuild Processes and Build Operations buttons. If processes
were in the list they have been replaced by the current HoleWizard
Process.
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2. Render the Bolt holes. Notice there is a
problemwith the part.

The 16mmendmill is scrapping the side of the boss during themove to each hole. We couldmodify
the Entry/Exit Clearance Z specified in Step Three of the HoleWizard. The second option is to
modify the clearance value in the process itself. Wewill use the second option so the drilling retracts
remainminimal.

Redoing the Operations

1. Reload the last operation or open Process #2.

2. Change the clearance
planes to be 1mm, as
shown.
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3. Click only the Rebuild Operations button.

If you click the Rebuild Processes, the data you just
changed will be replaced with the HoleWizard’s
recommendation. By clicking Rebuild Operations
directly we keep the association between these
processes and the HoleWizard. This will make
things easier if you need tomodify this hole shape
later.

Now, when the part is rendered, the endmill does
not interfere with the part.

M8 Tap Holes
As before, we will complete the four steps of the HoleWizard to create a circle of bolt tap holes.

Steps 1-4

Wewill now make tap holes on the top of the boss. Be sure to deselect the operations you just
made and delete the processes from the process list. This way you will not overwrite any
operations.

1. Deselect any operations.
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2. Click the Back button to return to StepOne
and click the Tap shape.

The Hole Wizard - Step Two: Tap Hole dialog appears.

3. SelectM8 from the Size pull-downmenu.

4. Enter the values as shown. Notice that M8
description is renamed "Custom".

Selecting a pre-set size from the Tap tablemakes defining a tapping operation very easy.
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5. Click theNext button.

We have the tools needed tomake this tap hole so the Hole Wizard Checker has not appeared.

6. In Step Three, set the clearance values as
shown.

We now need tomake the geometry to bemachined.Wewill use the HoleWizard’s point creation
capability to make a bolt circle of points on the boss.

7. Click the Bolt Circle button at the bottom of Step Three dialog.

The HoleWizard is now hidden. The Holes palette and the Bolt Circle dialog have appeared.

8. Create the Bolt Circle shown.
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9. Select the points in the
Workspace.

10. Click close on theGeometry Creation palette to return to the HoleWizard.

11. ClickNext and build the processes and operations for the tap holes.

12. Render the tap operations.

50mm Bore Hole
Again, we will complete the four steps of the HoleWizard to create the bore hole.

Steps 1-4

Wewill now make a bore hole in the center of the boss. Remember to deselect operations and
delete processes.

1. Click the Back button until you are at StepOne and select the Bore shape.
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2. Enter the values in Step Two as
shown.

Note that we aremaking the Full Diameter Depth (the 32mmentry) deeper than the HoleWizard
default. Every time the cursor enters the Bore Full Depth box (the 9.5mmentry), the HoleWizard
updates the Full Diameter Depth. thus you will need to enter the Full Diameter Depth after the Bore
Full Depth.

3. Click theNext button tomove to Step Three.

The Hole Wizard Checker opens because we don’t have a drill
defined that is sufficiently large enough tomeet the specified
Bore Drill Hole Diameter.

4. Click the Create Tools link.

The system created a tool for us, but we need tomove it to a different position.

5. Deselect the other tools that were selected for this process.

6. Right-click tool #17 that was created and chooseMove To.

7. Enter 8 and click theMove To button.

This will place the tool in the empty slot.

8. Close theMove tool dialog.
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9. Click the Back button then click the Hole Wizard

Checker button.

The 30mmdrill has satisfied the needs of the HoleWizard and a smaller drill has been chosen
for the first drill pass.

10. ClickNext to move to Step Three.

11. Enter the clearance values shown.
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12. Roll up the HoleWizard and select the
circle shown.

This is the 50mmhole wewill mill bore. The inner circle represents the 30mmdrill hole.

13. Unroll the HoleWizard and go to Step Four.

14. Build the processes and operations for the bore hole.

15. Render the Bore operation.

5mm Reamed Holes
There are four steps to creating these holes.

Steps 1-4

Wewill now make a reamed hole shape in the bore hole.

1. Select the Ream hole shape button.
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2. Enter the values for the Ream hole as
shown.

3. For this hole shape wewant the full diameter to be deeper than the automatic calculation. This
drill needs to go completely through the part. Override the depth value with 32mm.

4. Click theNext button.

The Hole Wizard Checker has not been
able to find a suitable tool.

5. Click the Back button andmake the Tip
Angle selection 118.



HoleWizard

22

A new drill does not need to be defined. There is a 4.5mmdrill in the tool list that has a 118° tip.
Since this tool will be used to drill through the bottom of the part, the tip angle used should not make
much difference.

6. Click the Next button.

The Hole Wizard Checker has nomissing tools now.

7. Enter the clearance values shown.

This will start the reamed holes at the bottom of the 50mmbore hole.

8. Roll up the HoleWizard and select the
circles shown.

9. Unroll the HoleWizard and go to Step Four.

10. Build the processes and operations for the reamed holes.
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11. Render the reamed holes.

Save the part asHole Wizard Tutorial Complete.vnc.
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HOLE MANAGER
In this exercise wewill use an existing part file to learn about the Holemanager’s capabilities. The
part file is based on an industry standard automatic feature recognitionmodel. If you have read
through the Solids Import manual, youmay be familiar with the part. The part has been simplified to
remove unneeded shapes and the holes have beenmademore complex. The part file has a stock
body to simplify the visualization when rendering.

Using the Hole Manager
In this section of the tutorial we will learn how to set up the part, run the HoleManager, group and
sort holes and edit hole data.

Part Set Up

1. Open the part file “HoleManager.vnc” located in the Sample Parts > Production> Tutorial Parts -
Required folder.

The only settings thismetric part has
is a stock definition located in the
body bag. Otherwise this part could
have just been imported. TheMaster
Clearance Plane is set to 250mm. All
of the tools and processeswill be
created by the HoleManager and the
HoleWizard.

2. Ensure the default metric values for the File > Preferences > Machining Prefs > Hole wizard > Hole
Data are the same as the following including changing the Two tool minimum diameter to 26mm.
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Running the Hole Manager

1. Select themodel.

2. Choose Features > Hole Manager and
click the Preferences button.

Use the Hole Manager Defaults as shown, but
we will change Top Clearance to 3mm, to
automatically add 3mm clearance to the top
of all holes. Wewill also send the tool past the
bottom of through holes by 1mm, by changing
Thru Hole Bottom Adjust.

ClickOK.

3. In the Hole Manager Dialog click the Run AFR button.

The Hole Manager will now have sixteen entries (ten drill holes and six bolt holes). The workspace
will have lines indicating the hole orientation, with an “X” indicating the top of each hole. Through
holes end at a point, Blind Holes are shownwith a line and a point at the bottom. Holes are color
coded (Drill -Green, Bolt Hole - Magenta. The full list of hole color codes can be found in Common
Reference>Miscellaneous>Colors>HoleManager.

Notice that no extra coordinate systems are added as holes are not associated with particular CS's.

Grouping the Holes

Rather than looking at each hole individually, let’s group the holes and then take a closer look. Go to
the HoleManager Preferences.
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1. Click Set Dialog Data in the Grouping Dialog
section. Ensure the settings are as shown and
clickOK.

ClickOK again to close the Preferences dialog.

2. Click the Auto Group button.

We now have five groups, including two groups of
similar holes and three groups of a single hole each.
Let’s have a look at these groups.

3. Move the HoleManager dialog so you can see themodel.

4. Double-click Group 4, the group with nine holes.

The HoleManager highlights the nine hole entries in the list and themodel faces that define the
nine holes and the point at the bottom of each hole is selected. These nine holes are simple drill
holes with a chamfer.

5. Double-click Group 1, the group with four holes.

The HoleManager highlights the four holes. These holes are bolt holes.
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6. Ctrl+click Group 2 and 3 and Ctrl+Double-click Group 5.

These groups comprise the three individual holes shown.

Editing Hole Data

Now that we are familiar with the holes and the groups, let’s get somework done.We are going to
modify the bottom angle of a group of holes to ensure we drive a drill deep enough.

1. Double-click Group 4.

If you widen the Hole Manager dialog and scroll over to the Bottom Angle column (10) in the Hole
Manager list, you will see that these nine holes have a bottom angle of 180°. The part was
modeled with these holes having a flat bottom.We are going to change these entries to have a
BottomAngle of 118°.
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2. Right-click on one of the highlighted holes in the list and choose Edit from the dropdown
menu.

3. Check the Bottom Angle button and
change the value to 118.

ClickOK.

Bymaking this change wewill drive the full diameter of the drill to the full diameter of the hole when
creating toolpath.

Looking at the data in the list we see that Z2 (the final depth of the hole) has been updated to
145.959 due to the change in the BottomAngle. The Part Top (Z) value is derived directly from the
model, thus it will not change with basic edits. BottomAdjust is used to account for stock.

Sorting Holes

Before we generate operations, let’s check the order of the holes in the groupswewill be
machining.When a group is created, the holes are placed in numerical order, based on hole
number. The number assigned to the holemay not be in an order you consider appropriate for
optimized toolpath. Therefore, we will sort the tools and re-order the holes in a group.

1. With Group 4 selected, click the Reorder button.

This brings up the Reorder Group dialog. This allows us to view the hole order and sort holes in a
number of ways including:
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a. Manually by drag and drop
b. Automatically by a planar sort, either an “S” pattern or by finding the next closest hole
c. Rotary sort
d. Reversing the current order
e. Sort by order between two points
f. Following a connected shape

2. Click theOptions button,
change Connect Lines to Thin,
and the Delay (ms) to 300.

ClickOK.

By changing these items, the order in which the holes will be drilled will be easier to see.

3. Click the Draw Order button.

The current drilling order is redrawn in red with a slight pause between each hole. The lines
show the numbered drilling order, with arrow heads indicating the direction of travel. The
current order is not optimal, so wewill change the order of the holes.

4. Click and hold themouse
over the Hole 15 entry
(H15), then drag the
position arrow up to just
above the Hole 7 entry
(H7) and release the
mouse.

5. Check the Show Order checkbox.
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We have not improved the order. We could drag several times to get the order right. Instead,
let’s try a different method to reorder the holes.

6. Click the Planar Sort button.

This dialog allows us to automatically sort points in either an “S” shaped pattern or by finding the
next closest hole.

7. Set the dialog as shown and click the Do It button.
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We instructed the system to sort the holes by
starting at the upper right corner then find the next
closest hole. Since this is a circular pattern, the
system just followed the bolt hole circle around,
counter clockwise, sorting the points.

If you click the Draw Order button your display will
look like the image shown.

8. ClickOK to close the Reorder Group dialog and save the new hole order.

Lets take a look at the other group with multiple holes, Group 1

9. Double-click Group 1 to ensure you’ve got the correct group.

The four identical bolt holes will be highlighted.

10. Click the Reorder button and then the Draw Order button.

These holes are in a logical order, but we want to set them tomachine in the same direction as
the previous group — starting at the top-right corner, progressing counter clockwise.

11. Click the Reverse button and then the Draw order button.
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The holeswill now be sorted as shown.

12. ClickOK to save the changes to the hole order.

Machining Using the Hole Manager
In this section of the tutorial, we will applymachining processes to five sets of holes.

Nine 14mm Drill Holes

Wewill generate operations on Group 4 using the HoleWizard.

1. Select Group 4 and click the Hole Wiz button.

The Hole wizard opens at Step 2. Step 1 is not needed because the type of hole is already
known and is displayed in TypeColumn #2 of the Hole Manager list.

2. Change the tip angle to 118 as shown.
Note that Spotting is deselected in favor of
Drill Chamfering.

ClickNext.

The Hole Wizard Checker runs, prompting you to create tools.
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3. Click the Create Tool link in the Hole Wizard Checker
for the Drilling process and click the Create Drill
Tool link for the Drill Chamfering process.

This provides uswith maximum tool reuse, minimizing the number of required tools.

4. Change the clearance to 15mm, as
shown.

Create the processes and operations then render.
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Be sure to deselect the operations beforemoving on to the next set of holes.

Four 20mm Bolt Holes

Wewill generate operations on Group 1 using the Hole Wizard.

5. Select Group 1 and click the Hole Wiz
button.

No changes in Step 2 are required.

6. ClickNext.

The Hole Wizard Checker opens, unable to find tools.

7. Click the Create Spot Drill Tool& Create Rough End Mill Tool links.

8. Close the Hole Wizard Checker.

We need to change the clearances. The default entered by the HoleWizard (3mmabove the
surface) will not raise the tool over the central bosswith the nine drill holes.

9. Change the clearance value to 150mmand clickNext.

10. Build the processes and operations, then click Finish.

11. Render the operations.
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The 20mm Drill Hole

The next group wewill generate operations for is the 20mmhole on the side of the part. This hole is
the only item in Group 2. Normally, we would not machine this hole next, because of its position.
However, we can create the operations and change themachining order later.

If we look at the hole’s data, we can see that the BottomAngle was defined as 124°. The Bottom
Angle of the hole isn’t particularly important to themodel or themachined results. If we wanted to,
we could simply select the BottomAngle entry and change the value to 118, as shown. However,
we do not need to do this. Wewill let the HoleWizard handle it.

12. Select Group 2 and click the Hole Wiz
button.

A warning appears about the 124° Bottom
Angle used for this hole.

13. Ignore the Hole Wizard Checkermessage and close it.
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14. Enter the hole definition as shown.

You will likely have to change the Tip Angle from 90° to 118°, as 90° is the default, unless you have
changed the HoleWizard preferences. The only other change you will need tomake is to set the
Wizard to perform a Spotting then a Drilling operation.

15. Click theNext button.

The Hole Wizard Checker displays again,
prompting you tomake a tool.

16. Click the Create Tool link and create the Processes and theOperations.

Be sure not to overwrite any existing operations.

The HoleWizard selected the Spot Drill created for the prior hole and the clearances are
adequate.

The 40-20mm Reamed Hole

The next hole wewill create toolpath for is the hole on the angled boss. The HoleManager has
identified this hole as a Bolt Hole, we are going to change it to be a ReamHole. First, to minimize the
number of tools the systemwill try to generate, we need to adjust the length of Tool #5.

1. Open Tool #5 and change the length to 120.
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2. Double-click Group 5, and click the
hole Type in the highlighted entry as shown.
Change the type to Ream.

3. Click the Hole Wiz button and set the
process parameters as shown.

4. Click theNext button.

The Hole Wizard Checker opens, prompting us for a 40mmReamer.

5. Click the Create Tool link.

The default clearances are acceptable.

6. ClickNext and create the processes and operations.

7. Create the toolpath and render the operations.
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The 100-80mm Bore Hole

The remaining hole, 100mmat the top with an 80mm through hole will be cut with a boring tool.
Because of themethod we have chosen tomachine the hole, it needs to be cut in two groups of
operations. Classifying the hole as a Bolt Hole provides limitedmachining options (Spotting,
Drilling, Drill Chamfering, and Spot Face) that do not include bore cycles. The boring options in the
HoleWizard do not provide for amulti-depth hole. Therefore, we will first cut the 80mmportion of
the hole and then the 100mmportion.

1. Double-clickGroup 3. This will highlight the Bolt hole in
the Holes list.

Right-click the highlighted entry and change the hole
entry type to Bore, Thru by clicking the Through/Blind toggle
option in the right-clickmenu.

2. Click the Hole Wiz button in the HoleManager dialog.

Before we begin creating these operations, we need to check the HoleWizard’s Bore andMill
Bore preferences.Wewill change one of these items and examine others to understand what we
are doing.

3. Right-click the title bar of the HoleWizard and choose Hole Data.
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In the Bore tab of the Preferences dialog, the
Minimum diameter for Big Bore setting of 51mm
indicates that this hole (80mmand 100mm
diameters) qualifies for the Big Bore Stock
Allowances. The Through bore over travel setting
tells us the bore will go through the bottom of
the hole by 6mm. Themaximumamount of
material the bore will remove is 3mm, 3mmor
1mm, depending upon whether the pass is a
rough, medium or finish pass.

4. In theMill Bore tab, make sure theMaximum end mill size is set to 25.

TheMaximumendmill size states that the systemwill
not define amill tool for amill boring process that is
larger than 25mm. Cuts aremade at the tools radius.
Youmay recall that we changed a two drill setting to
26mm. That setting will allow us to use a single 26mm
drill as an entry for a 25mmendmill. If the value was the
smaller default the systemwould use a smaller drill as
an entry for the 26mmdrill.

5. Close the Hole Data Preferences dialog and set the Hole Wizard data as shown, starting with the
bore drill hole value.

The bore drill hole value will togglemany other
settings, so it is a good place to start. With the
Chamfer and Finish Diameters being identical,
we indicate this will be a straight 80mmhole
through the part, ignoring the 100mmsection of
the hole for now.Wewill spot the hole, then send
a 26mmdrill through the part, then pocket it with
a rough endmill and finish the hole with a finish
bore. We can predict that the endmill will have a
25mmdiameter, due to the preference setting
we changed.
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6. ClickNext and create the tools
the HoleWizard Checker is
looking for.

Choose the Create Rough End
Mill Tool link.

7. Create the processes and operations.

Wewill now cut the 100mmwide section of the hole.

8. If it is not already selected, select Group 3.

9. Click the Hole Wiz button and click the Back button.

We need to change the process from a thru bore to a blind bore process.

10. In StepOne click the Bore hole shape.

11. Enter the parameters as shown and click theNext button.

The drill diameter of 80mm is rather important. Without it, the endmill would cut air, trying to remove
material that is not there. The 80mmvalue tells the system that, when it gets to themill rough
process, we removed 80mmof material in a drilling process.We did not make the process because
we did not need to.

12. Create the tool suggested.

13. Create the toolpath and render the operations.

This completes the part.
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Using Hole Manager with AutoWiz
In this section of the tutorial, we will perform the samemachining operations on the same part, this
time using AutoWizard to automate the process. Although Autowiz will work perfectly well for
simple parts, in more complex parts it may need slight adjustment.

1. Open the part file “HoleManager.vnc” located in the Sample Parts/ Production/ Tutorial Parts -
Required folder.

2. Select themodel.

3. Choose Features > Hole Manager. You can leave this dialog open thoughout the tutorial.

4. Click Preferences

5. Under AFR / Import Dialogmake sure Do not use Dialog is checked.

By selecting this option, the
HoleWizard will use the
current settings in dialog
boxes. The dialog boxeswill
appear during HoleWizard
operation, but will require no
input. In this way, you can
determine the amount of
automation versus control of
individual settings throughout
the HoleWizard process.

6. ClickOK.

7. ClickRun AFR.

8. Click the Auto Group button.

We now have five groups including two groups of similar holes and three groups of a single hole
each.

9. Click in the Group box and ensure all groups are selected. (Ctrl-A).

10. Click Autowiz.
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11. FourteenOperations are
successfully created,
however when we render
the operations there is a
problem. The first operations
are scrapping the part.

We need to change the clearance level in the operations that machine the 4 bolt holes (H1-4). The
default entered by the HoleWizard (3mmabove the surface) will not raise the tool over the central
bosswith the nine drill holes. This is because HoleWizard addresses individual holes and cannot
take into account what elsemight be surrounding them. There are two ways to approach fixing this.
Either you can edit the clearanceswithin the HoleManager, or you can directly edit the processes.

Edit Hole Manager

1. In the HoleManager dialog (which should
still be open), change the Top clearance in
the GroupOne Bolt Holes from 3 to 150.

2. Double-clickOperation tile #1. The HoleWizard opens at Step Four. Click the Rebuild
Processes button then the Rebuild Operations button.

3. Render the part.
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Edit Hole Processes directly

1. Double-clickOperation tile #1. The Hole
Wizard opens and the 3 Processes
associated with it appear in the process list.
Close the HoleWizard aswe do not need it.

2. Click on the first Process Tile. You will see
that Transition between Holes is set to R level. In
order to clear the part we need to change this
to Part clearance.

3. Click the Part Clearance option and close the
dialog.

4. Open the other two processes in the process tile list and change Transition Between Holes to Part
Clearance for these in the sameway.

5. In theMachining Dialog click Redo.

6. Render the part.

The clearance is now adequate and the tool no longer scraps the part.

The part is complete.
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Feature Manager
In this exercise wewill add features to a part using the FeatureManager and then use the features
tomachine the part.

1. Open part file “Mill Feature.vnc” located in the Sample Parts > Production> Tutorial Parts -
Required folder.

If you look at this part you will see that there are pockets on three of the surfaces.

2. ClickFeatures > Feature Manager on theMainMenu, to open the FeatureManager
Dialog.

Keep this dialog open throughout the tutorial.

3. Select the pocket shown below. (Click the bottom of the pocket, then right-click it
and choose Select> SelectWall Faces.)

4. Ensure that Face Selection (on the floating Taskbar) is enabled .

5. In the FeatureManager dialog, click the Create Feature fromSelected button and enter
details as follows.

If you cannot see the color displayed on your screen, ensure that the Feature Color display
mode is on. This is located in the Floating taskbar.
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6. Repeat the last two steps, until all pockets on the top surface have been added to the Feature
Manager.
Your FeatureManager dialog and screen will look as follows:

(The choice of color is not important.)

7. Now select the side pocket, making sure to look all around the part to ensure all surfaces are
selected. Save the feature as Side Pocket 1.

Wewill now create an attribute for the CS.

8. In the FeatureManager click the Create new

Attribute button . Enter the following in the dialog.

9. We need to edit the Features to add this
new attribute. Click in the newly created
column and add the following CS values:

The part is now ready to bemachined. First we will load some tools from the Tool list we set up in
theMill tutorial.
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1. Right-click on any Tool Tile to display the Tool list menu as shown.

2. Select the option View/Edit Tool List and navigate to the sample file tools.tlst.

3. ClickOpen. The tool list opens.

4. Ctrl-click the tools as shown to select
them, then right-click and choose the option
Import to part.
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The tools will be inserted into the tool tiles. You can also drag the tools individually onto the tool tiles
- Rough Endmill to Tile #1, Finish Endmill to Tile #2.

5. Close the Tool List dialog.

6. With Tool #1 create the following Pocketing
Process.

You will notice theMill Feature Tab is bold, meaning that settingswill be applied.

7. Enter the settings shown below into the tab.
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Approach and Retract Z are set to
Incremental. The distance between the
Clearance Plane and the Top Surface
will be updated for each hole.

Top Surface and Depth Z are set to
Automatic. The value will come directly
from the geometry of the user feature.

Notice theMach CS Dropdown is no
longer available. This is because the
Machining CS details are taken from
the attribute set in the Feature
Manager.

8. With Tool 2, create the following Finish
Pocketing Process. TheMill Feature Tab
will already be populated with the values
set in the previous process. Leave these as
set.



50

9. In the FeatureManager dialog,
select all Features (Cursor on
first Feature, then Shift-click
bottom Feature, or Ctrl-click
each of the rows).

10. Click Do it on theMachining dialog.

Fourteen operations are created., machining each of the pockets selected in the Feature
Manager.

11. Render the Operations.

Try adding the surfaces located on the bottom of the part to the FeatureManager and thenmachine
them also.

Drilling Multiple Orientations using Hole Feature
This is a short exercise to demonstrate how the Hole feature tab, used in combination with Hole
Manager can create operations for holes in multiple Orientations.

Please note that Mach. CS “FromHole Feature” in the Hole Feature Tabmeans that holes will be
grouped together according to their orientation. One operation will be created for each orientation.
For each of these operations, if there is already a CS that is aligned with hole depth axis, that then
will be the CS assigned to that operation. If there is no CS that matches the hole depth axis, then a
new CS will be created and assigned to the operation.

1. Open part "Hole Feature CS.vnc". This already has two tools set up.

First we need to select the holes tomachine.

2. Open Hole Manager, select the part and Run AFR.

24 Holes are found.
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3. Select all the holes (Click into the HoleManager and (Ctrl-A)). Then click theMake Group
button.

A single Group is created with 24 holes.

4. Click onGroup 1 to select it, then click
Reorder.

5. In order to see the toolpath correctly we will change the Display Options. Click theOptions button
at the bottom right of the Reorder Group dialog. Enter the following:

6. Click onGroup 1 and click Reorder. This opens the Reorder Group dialog.
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7. Now click the Draw Order button. This will highlight and number themachining order. You will
see that the toolpath is all over the place. If this is not working, ensure the Show order checkbox
is checked.

8. Now Click Rotary Sort, enter details as shown below then click Do it .

The toolpath is sorted.
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9. ClickOK and return to Hole Manager. Group 1 should remain selected. Any holes selected within
HoleManager will be the ones used in the operations. Make sure the HoleManager dialog is
left open, this ensures that the Hole Feature Tab can use the values contained within Hole
Manager.

Now wewill create two processes, one to Spot drill each hole and the other to Drill them.

10. Create a Holes Process using the 2.00 Spot tool (Tool #1).
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11. Create another Holes Process using the 3.5 Drill (Tool #2).
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12. ClickDo it on theMachining dialog.

A total of six operations are created, two for each hole orientation. You will note that hole depth,
orientation and top clearance values are provided by the HoleManager and require no user
input.

13. Save the part.
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